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The Dytran 7543A USB Digital Tri-axial Accelerometer combines a 3-Axis MEMS accelerometer
with a microcontroller to create an intelligent sensor.

1 Device Features
-System components:

USB 7543 Accelerometer
6330A 4-pin to USB cable
VibraScout™ Software and VibraScout™PP on CD

-The 7543A is powered by a PC’s USB bus.
-Temperature sensor.

-Real-time acquisition and USB transfer of acceleration (including Static Inclination) and
temperature data.

-Built-in firmware handles USB communication and provides a number of unique features
including:

Storage of device serial number
Storage of accelerometer and temperature calibration data

Additional storage available for customer information - e.g. last calibration date, etc.

2 VibraScout™ Software Features
-Real-time scrolling plots of acceleration data with display of min, max, mean

-Plot features: zoom & pan, display of individual sample values, save to image file, printing
-Real-time display of X and Y axis inclination angles and temperature
-Real-time logging of data to delimited file for importing into spreadsheet

-Both auto and smart triggering modes
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-Fast Fourier Transform Plots of all orthogonal channels.

- APl available as .NET dll

3 Acronyms used in this manual

GUI- Graphical User Interface

USB- Universal Serial Bus

FFT- Fast Fourier Transform

PSD-Power Spectral Density

JPG-Joint Photographic File format

ASCII-American Standard Code for Information Interchange

TDMS-Technical Data Management Solution (Binary and ASCII file saving option for smaller file
sizes with stored header information)

UFF58- Universal File Format 58 (purely binary file format for data recording)

4 Recommended Minimum System Requirements (for operation at

maximum 1600 Hz BW)

CPU: i7 870 2.93GHz or faster
RAM: 8GB
0S: Windows 7 64 bit

5 Basic System Requirements
Free Hard Disk Space: 2 MB (not including .NET Framework 4)
OS: Windows XP or Windows 7
One available USB 2.0 port

6 Installation
Insert CD into an empty CD/DVD drive. From My computer double click on CD/DVD drive.
Navigate to VibraScout Acquisition Folder. Double click VibraScoutSetup.exe to run the setup
file. Follow the on-screen instructions shown below to install the VibraScout application.

VibraScoutSetup,msi

Y 1
—_ - =
W7 gijtr:ScnutSetup.exe inl Windaws Installer Package
" l‘ 726 KB

If necessary the .NET 4 Framework will be installed (internet connection is required).
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i VibraScout

i VibraScout

Welcome to the VibraScout Setup Wizard Select Installation Folder

The installer will guide pou through the steps required to install VibraS cout on your computer. The installer will install Yibra5 cout ta the following falder.

Taingtal in this folder, click "Nest". Toinstal to a different folder, enter it below ar click "Browse"

Falder:

C:\Pragram Files\Dytran'WibraS couts Browse...

WARMNING: This computer program is protected by copyright law and intemnational treaties.
Unautharized duplication or distribution of this program, or any portion of it, may resulk in severe civil
aor chiminal penalties, and will be prosecuted ta the maximum extent possible under the law.

Install Vibra% cout for yourself, or for anyone who uses this computer:

() Everyone
&) Just me

Mewt » I Cancel ] [ < Back

Figure 1: Step 1 Figure 2: Step 2

& VibraScout

5! VibraScout

Confirm Installation License Agreement

The installer is ready to install YibraS cout on pour computer, Please take a moment to read the license agreement now. If you accept the terms below, click "l
Agree'’, then "Mext". Otherwise click "Cancel".
Click "Mext" to start the installation.

The Dytran Instruments, Inc. (Dytran) VibraScout™ software (the Software)
application available for download via the Dytran website, via email, or made
available on portable storage devices shipped with Dytran products is a free
license for Dytran customers to use with Dytran products. Dytran

encourages you to know the possible risks involved in the download and use
of Software from the Internet. You are solely responsible for protecting
yourself, your data, your systems and your hardware used in connection

with the Software. Dytran will not be liable for any damages suffered from the .,

)| Do Not sgiee @) | Agree

[ Cancel ] [ < Back ] [ Mext > l\] [ Cancel ] [ < Back ] [ Ne:t>
Figure 3: Step 3 Figure 4: Step 4
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I8 VibraScout

i'.‘!r" 'ﬁhraScu ut IZH:JE

Installing VibraScout A Installation Complete LA

i

YibiaS cout iz being installed WibraScout has been successfully installed.

Click "Close" to exit.
Pleaze wat...

Pleaze uze ‘Windows Update to check for any critical updates to the NET Framewark.

< Back Mext > Cancel < Back
Figure 5: Step 5 Figure 6: Step 6

7 Starting the VibraScout™ application

The 7543A Accelerometer must be connected to a USB port prior to starting the VibraScout™
application or the application will not function. After connecting the 7543A to a USB port, the
device enumerates as an external storage device with 5 KB of available file storage. The drive
space can store up to three VibraScout™ parameter files or other customer files. The on-screen
enumeration window is the first indication that the USB communication between the 7543A
and the host PC is functioning properly. The enumeration window may be closed prior to
running the VibraScout™ application.

Fls Edt View Favortss Tods Heb [
¥ | POseamn Folders

jikdress | v Foy B

Figure 7: Enumeration window.
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Run VibraScout™ (All Programs -> Dytran -> VibraScout™). After detecting the 7543A, the
software will perform a self-test to verify that the device is functioning properly and then
display the VibraScout™ application.

8 GUIlayout & Description of Software Features
1. Configuration Screen

Model 7543A USB Triaxial Accelerometer S/N 115

o Device Info
o Acquisition o Offsets

‘ |

i Model # 7543A X[g] 0.085

[ Approx Bandwidth [Hz] 1600 -

I SN 115 Y(g] 0085

f UserInfo  S. Taylor-Used on 3/28/12 to Z[g] 0.890

| monitor unit B|

i Pitch [deg] 54

M

i Roll [deg] 5.4

! Acquire
|

[

f o Data File

|

[l

! Ci\Usersissherian\Desktop\Vibration_110042012115401 it | Browse |

L Write User Info

Figure 8: Configuration Window

2. File Menu
All GUI fields (bandwidth selection, FFT plot selections, etc) are stored in a configuration file.
Fields are read from the default file VibraScoutConfig.xml when VibraScout™ is launched.
The file is updated by selecting SaveGUI Settings from the File menu. Fields may also be
saved to other filenames using Save GUI Settings As and then read back using Load GUI
Settings. This feature is useful for saving/loading location-specific parameters. The name of
the current file is displayed below the menu bar.

REV B 10/18/12, ECN 8972



Current plot data can be exported to a selected tab-delimited file for convenient importing in
a spreadsheet or other application such as the VibraScout Post Processor. This feature
provides an alternative to the data log file by allowing the user to export data after
acquisition.

3. Device Info
Model # and Serial # are stored in the device EEPROM and read when the VibraScout™
application is launched. Device memory is also available to store user information. Enter up
to 180 characters in the User Info field and click on Save User Info to store the information in
non-volatile memory. When VibraScout™ is launched, the information will be read from the
device and appear in the User Info field.

4. Approximate Bandwidth

Select the desired bandwidth based on the application requirements. The noise level
increases with bandwidth, so selecting a lower bandwidth will provide improved signal/noise
at the expense of frequency response. The 7543A sample rate is equal to approximately
twice the selected bandwidth. In cases where data overflows occur due to inadequate
system resources (CPU speed, RAM), selecting a lower bandwidth will usually eliminate the
overflows. See the section on the Data Integrity indicator for more information.

5. Data File Settings
The Data File path is selected with the Browse button. Data are saved as tab-delimited text

for easy importing into a spreadsheet or other application when the Log To File box is
checked in the Acquisition screen. Software automatically appends date and time code to
the end of the file name for easier identification of test sequence. Data file is closed and this
field is cleared every time acquisition is stopped. Selecting the Log To File box will prompt
user for creating a new data file.

6. Offsets
The 7543A is calibrated at the Dytran factory along each orthogonal axis using precision
fixtures and earth’s gravity. When the 7543A is placed at any random position, the Offsets
Acquire button allows the values for the three acceleration axes pitch and roll to be captured
and set to zero. Therefore, relative measurements may now be made from that position.
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The Relative mode must be selected on the Acquisition screen so offsets will be subtracted
from the respective data during acquisition.

To reset the 7543A to factory defaults, simply select the Abs radio button in the Acquisition
screen.

7. Acquisition Screen
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B el o Model 7543A USB Triaxial Accelerometer SIN 115

VibraScoutCorfigsaml
Configuration| Acquisition

Acceleration X

| Trigger 0 Clear
Auto R 02575

AEEL 00.013 |
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Figure 9: Acquisition Window

8. Trigger Modes

Acquisition is started by enabling one of the two trigger modes. Auto Trigger mode is
amplitude independent so that triggering begins immediately and runs continuously when
enabled. i.e. similar to an oscilloscope auto triggered scroll mode.

Smart Trigger mode starts data acquisition when the first change in value on any of the three
acceleration axes exceeds the specified threshold in Units of Gpk-pk. Acquisition is to be
stopped by user. Data are monitored continuously and the maximum change in value
(maximum of the three axes) is displayed in the Cur Value field.

9. Inclination[deg] Display
Static inclination values in both X and Y axis, are updated continuously when the Auto or
Smart Trigger is enabled. These fields are only valid in static angle measurement mode.

10. Temperature Display 0
The temperature is measured and updated continuously when the Auto or Smart Trigger is

enabled.
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11. Data Integrity Indicator

The Data Integrity box indicates one of three conditions: OK, Overflow, or Checksum Failure.
An overflow condition occurs when system resources are inadequate to sustain data
processing at the selected bandwidth. This might be due to CPU speed, insufficient free
memory or cpu/memory - intensive processes running concurrently with the VibraScout™
application. An overflow indicates a loss of some data samples. The condition can usually be
eliminated by selecting a lower bandwidth. A Checksum Failure indicates a fault in USB
communication. If this occurs, check the cable connection between the 7543A and the PC.

12. Clear Button
The Clear button clears the plots and the min, max, mean values. Plots are automatically
cleared at the start of every acquisition.

13. Plot Vertical Axis Scaling
Range and Offset values for each axis can be specified or Auto-scaling can be selected to
adjust the scale when an acceleration value exceeds the current range.

14. Absolute and Relative Mode
In Absolute mode (Abs), acceleration data are shown relative to the earth's gravitational field
using the factory calibration. In Relative mode (Rel), the acceleration offsets are subtracted
from the data using user selected Offset values acquired in the Configuration screen. See #6
Offsets in the Configuration section.

15. Log to File
Data File logging is enabled/disabled by the checkbox. The name of the data file and related
parameters are first specified in the Configuration screen. If no data file is specified in the
Configuration screen and this check button is selected, a data file prompt menu will pop up
requesting a new data file to be created.

16. FFT

The frequency spectrums of the three acceleration axes are calculated and displayed by
clicking the FFT button. The FFT is performed on all plot data. FFT plots can be displayed in
Linear or Log format and the displayed frequency range is selectable. The maximum
selectable frequency is equal to 1/2 the sample rate.

REV B 10/18/12, ECN 8972
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FFT data can be exported to a delimited file by clicking the Export button on the FFT form.
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Figure 11: FFT Linear format
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Figure 12: FFT Log format

17. Plot Features
Press the Stop button to halt chart scrolling. Left-clicking, dragging, and releasing the cursor
will zoom the plots in a desired location. Vertical and horizontal scroll bars are displayed
when data exceed the vertical and horizontal ranges respectively.

Acceleration X

15 12 21 24

Figure 13: Select area on plot

Acceleration X

13

Time [zec]

Figure 14: Zoomed plot
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Right-clicking on plots (both time-domain and FFT) will display a context menu with available
features - zooming, saving, printing, etc. as shown on the menu below.

Acceleration X Acceleration X

[ 22,4394531250002, 2,4336 )

Copy

Save Image As...

Page Setup...
Print. ..

. S[‘low Point ¥alues
Unoom

Undo &ll ZoomPan

Ac Set Scals ko Default
T e
Figure 15: Point Value Display Select Figure 16: Point Value Displayed

9 Custom Applications
An API is available for customers who would like to build custom applications for the 7543A.
The API provides support for any .NET-compatible client application - e.g. LabView, C#, etc.
Please contact Dytran at sales@dytran.com or 818-700-7818.

Custom application development is also available.
Please contact Dytran at dchange@dytran.com or 818-700-7818 for more information.

10 VibraScout™ Post Processor Software Features
VibraScout™ Post Processor software is designed to provide a user with the tools to apply non-
linear interpolation to resample raw data that are recorded with VibraScout™ software at
higher frequencies to improve signal resolution. Data is valid only up to 1.5KHz after
applying the post processing. This mathematical interpolation is performed using the
Whittaker-Shannon interpolation technique to reproduce the recorded real signals with
the proper amplitude.

Software features include:
e Plot recorded data from the VibraScout™ software

e Zoom and select a specific timeframe of recorded data for post processing

REV B 10/18/12, ECN 8972
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11

12

e Reproduce interpolated oversampled data to provide better resolution of vibration
signals

e Multiple file types to export to including: ASCII, time history.JPG files, TDMS
binary files of time history data readable in Microsoft Excel, PSD and FFT plots in
Joint Photographic file format.

e Display of recorded average temperature

Minimum System Requirements
Personal Computer running Windows XP/Vista/7 x86 or Windows XP/Vista/7 x64 with at least
2GB RAM or higher. 163MB of free hard disk space is required.

Installation
Please contact Dytran Instruments, Inc. at (818) 700-7818 for latest software revision. Check software
revision while installing on welcome screen as in Figure 18.

To Install from CD:

Insert CD into an empty CD/DVD ROM drive. Navigate to My Computer>CD/DVD ROM
Drive>VibraScout PP folder and double click on setup.exe. This will start the installer. Follow the
step by step prompts to completely install the Post Processor software.

Leave all file paths in their default directories.

Note: Please make sure all windows applications are saved and closed before starting
installation as system will ask to restart for the first time of installation.

After installation is completed, Installer will create a shortcut on the Desktop and in the Start
Menu programs under Dytran>VibraScoutPP folder.

REV B 10/18/12, ECN 8972
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Figure 22: Installation Completed

13 Starting the VibraScout™ PP application

After System reboot, from the Desktop, double click the VibraScout™ PP icon. M

14 Software Operation
I.  Software Revision
Press F1 key on the keyboard or navigate to Help>About to display the current version and date of
the Software. See Figure 23 for location on window. Press anywhere on the window to hide it.

Dytran Instruments
VibraScout Post Processor

“Syftwace Revision

Forw A BA4T01T (A 17

Figure 23: Software Revision
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Il. Select Data Tab

1.

L

Select File- to select the data file recorded using the VibraScout™ software. A prompt window will
pop up asking for data file to be selected. Navigate to folder where file exists and double click
on data file.

Note: all exported files will be saved to the same directory as the original data file directory.

Model Number- Once file is opened, Model number of the transducer will be displayed in this field.
Serial Number- Serial number of the transducer will be displayed in this field.

Temp[deg©]- Average temperature recorded during test will be displayed in this field.

Continue- Click on Continue to proceed.

Channel- Select the channel in Axis with the vibration in the specified data file. This will allow user to
zoom in on specific window of the vibration time history.

Zoom- allows user to zoom and select a specific window of the recorded data as opposed to processing
the full time history. This feature works with the cursors in #9. You have to set the cursors at the
desired window and then press Zoom.

Reset- If the zoomed window is NOT the desired window in #9, then press reset to display all data read
from the data file again. This will allow user to display zoomed plots multiple times until desired window
is selected.

Plot- Set the cursors to the desired window to be processed. This in combination with the zoom button
will define the window to be post processed. Setting the cursors alone will NOT define the window.
Zoom has to be pressed to select the desired window.

10. Continue- Once desired window is selected Pressing continue will allow to proceed to the next steps.

Note: If Continue is pressed without Zoom, all data recorded in data file will be processed. This will take

longer to process depending on original file size and desired output files.

[} Set Sampling Parameters Tab

11. Type in Operator name and Test Description to be exported on Selected Output Plots.

12. Select Output Format- Select the desired output file formats by checking the box next to them. The

software outputs the following formats

a. ASCII- is a comma separated text file saved in .csv and can be imported to Excel. This file can get
very large based on the window selected.

b. TDMS Binary- is a combination of binary and text file format. This file format is more
convenient as it can be opened in Excel by double clicking the file. It will separate the header
information and the re-sampled raw data in 2 different sheets in excel.

c. JPEG- will export time history plots of all channels in *.jpg file format.

UFF58- is the universal file format in binary. This file format allows for further data
manipulation in other post processing software such as Matlab, C++, LabVIEW, etc.

e. Power Spectral Density- will export the Power spectral density plots of all channels in *.jpg
format. (see note 13 and 14 for further parameters)

18
f.  Fast Fourier Transform- will export the FFT Plots of all channels in *.jpg format.
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13. Re-sampling frequency- There are 7 different settings for re-sampling recorded data: 10KHz, 20KHz,
30KHz, 40KHz, 50KHz, 70KHz, and 100KHz. It is recommended to use the lowest available sampling rate
for longer duration of recordings to prevent system from running out of memory during processing.

Window- is the PSD window and Hanning window is the most commonly used to perform the PSD
calculations.

Units- there are 2 settings for this field. Most commonly used for PSD is EUA2/Hz.

14. Min. Frequency (Hz) — enables zooming PSD and FFT plots to start from frequency set in this field.

Max. Frequency (Hz)- enables zooming PSD and FFT plots to end at frequency set in this field.

Graph Type — exports FFT and PSD plots in either Linear or Logarithmic.

15. Save- After setting all the re-sampling parameters, press the save button and software will export all
selected file formats to the same directory as the original recorded data file. A series of plots will pop up
and disappear displaying the JPG, PSD, and FFT plots as selected.

16. Exported Files Directory- All exported files will be saved to the directory listed in this field. This is the
directory for the original data file selected in #1.

Process Completed- this indicator will iluminate bright green once the saving process is complete. It will
reset to matte green when a new file is selected.

17. Exit- once export is completed in step 15, there are 2 ways to exit the program. Pressing the Exit button
or from the File menu Exit.

See Figure 24-26 for controls and displays.

Note: both continue and save buttons will be disabled if no data file is selected.

AL Saasl P W W

VibraScout Post Processor

Figure 24: Data Setup Window

19
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Figure 25: Select specific window for Re-sampling

VibraScout Post Processor

A e |

=————-————a

Figure 2_6: Re-sampling and output file parameters

20
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15 Software License, Restrictions, and Disclaimer

LICENSE: The Dytran Instruments, Inc. (Dytran) VibraScout™ software application (the Software) available for
download via the Dytran website, via email, or made available on portable storage devices shipped with Dytran
products is a free license for Dytran customers to use with Dytran products. Dytran encourages you to know
the possible risks involved in the download and use of Software from the Internet. You are solely responsible
for protecting yourself, your data, your systems and your hardware used in connection with the Software.
Dytran will not be liable for any damages suffered from the use of the Software.

RESTRICTIONS: Neither the Software Licensee nor any Licensed User may rent or lease the Software.
Neither the Software Licensee nor any Licensed User may modify, reverse engineer, decompile or
disassemble the Software.

DISCLAIMER: BY USING THE SOFTWARE, YOU EXPRESSLY AGREE THAT ALL RISKS ASSOCIATED
WITH THE PERFORMANCE AND QUALITY OF THE SOFTWARE IS ASSUMED SOLELY BY YOU.
DYTRAN SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE,
EVEN IF DYTRAN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

THE SOFTWARE IS MADE AVAILABLE BY DYTRAN "AS IS" AND "WITH ALL FAULTS". DYTRAN DOES
NOT MAKE ANY REPRESENTATIONS OR WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED,
CONCERNING THE QUALITY, SAFETY OR SUITABILITY OF THE SOFTWARE; INCLUDING WITHOUT
LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, OR NON-INFRINGEMENT. IN NO EVENT WILL DYTRAN BE LIABLE FOR ANY INDIRECT,
PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES THROUGH THE USE OF THE
SOFTWARE HOWEVER THEY MAY ARISE AND EVEN IF DYTRAN HAS BEEN PREVIOUSLY ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.

REV B 10/18/12, ECN 8972
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Model Number DOC NO
7543A PERFORMANCE SPECIFICATION PS7543A
| USB TRIAXIAL ACCELEROMETER [ REVC, ECN 9403
This family also includes:
Frequency Non-Linearity Noise Differential
Model Input Range (g) | response (Hz) (%F.S) Max.Shock (Ug/VHzZ)

* USB/MEMS TECHNOLOGY

« EMBEDDED MICROCONTROLLER

* HERMETICALLY SEALED

* DC RESPONSE

* POST PROCESSOR INCLUDED TO EXTEND
FREQUENCY RESPONSE

Device Features:

Dytran model 7543A is a unique and innovative solution for fast and cost effective data acquisition. The only addition that is required
is a personal computer and it is ready to take data. Model 7543A is USB powered, so no additional external power supply is required.
The software package supplied with each sensor allows for real time, three directional acceleration acquisition along with
temperature data and pitch/roll data. The standard USB protocol handles all the sensor communications with the PC and provides the
following information: storage of the acceleration and temperature information, storage of pitch/roll data, real-time scrolling plots of
acceleration data with display of min, max, mean, real-time logging of data to delimited file for importing into spreadsheet, both auto
and smart triggering modes, digital filters to improve signal/noise ratio, real-time data compression to FFT, and many more.

Refer to the performance specifications of the products in this family for detailed description.

Supplied Accessories:
1) Accredited calibration certificate (ISO 17025)
2) Mounting screw model 6935, qty 2

Notes:

[1] Over the rated Temperature Ramp Rate .

[2] Mates with Dytran cable assembly 6330AXX ("XX = Length in FT)

[3] Accelerometer bandwidth is 1.1KHz. Data can be reconstructed using the VibraScout Post Processor

ENGLISH | | S| Software using the Whittaker-Shannon Interpolation method.
PHYSICAL [4] In the interest of constant product improvement, we reserve the right to change specifications without notice.
Weight, Max 0.6 oz 17 grams [5] Measured at 100Hz 1Grms per ISA RP 37.2
Connector [2] 1/4-28UNF 1/4-28UNF
Material Ti-6Al-4V Ti-6Al-4V s TYPICAL FREQUENCY RESPONSE
£ 30
f =
8
2 10
PERFORMANCE 2
Input Range +16 g +157 m/s’ + -10
=1
Frequency Response, +/- 10% 0 - 500 0 - 500 %_
Frequency Response (3dB), Nominal [3] 0-1100 Hz 0-1100 Hz g -30 T T T T |
Freq. Toll. Over Temp (0.5 Deg C/min) 0.50 % 0.50 % 0 100 200 300 400 500
Output Noise, Differential , Typical X,y = 290; z = 430 ugrmshi Hz X,y = 2845; z = 4218 wm/s? N Hz Frequency (Hz)
Non-Linearity, Typical 0.5 % F.S 0.5 % F.S
Cross Axis Sensitivity, Typical 1 % 1 % T
140
ENVIRONMENTAL 356]
Maximum Mechanical Shock +10000 gpk +98100 mi/s? peak 1
Operating Temperature Range -40 to +185 °F -40 to +85 °C
i PIN 4 GND— PIN 1 USB Vee
Scale Factor Temperature Shift [1] -56 to +56 ppm/°F -100 to +100 ppm/°C 428 UNE2A (Vbus)
1/4-. -
Seal Hermetic Hermetic 4-PIN CONNECTOR /
16
Co o @ I
ELECTRICAL I L 15
Operating Voltage | 3.8106.0 ] vDC [ 3.8106.0 | vDC 3a]
Power Supply Rejection Ratio, Typical | 44 | dB [ 44 | dB PIN 3 USB DATA+— L—PIN 2 USE DATA -
Units on the line drawing are in inches. Refer to 127-7543A for more information.
Y 21592 Marilla Street, Chatsworth, California 91311 Phone: 818.700.7818 Fax:818.700.7880 www.dytran.com
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